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Disclaimer

Thunderhead Engineering makes no warranty, expressed or implied, to users of PyroSim, and
accepts no responsibility for its use. Users of PyroSim assume sole responsibility under Federal
law for determining the appropriateness of its use in any particular application, for any conclu-
sions drawn from the results of its use, and for any actions taken or not taken as a result of anal-
yses performed using these tools.

Users are warned that PyroSim is intended for use only by those competent in the fields of fluid
dynamics, thermodynamics, combustion, and heat transfer, and is intended only to supplement
the informed judgment of the qualified user. The software package is a computer model that may
or may not have predictive capability when applied to a specific set of factual circumstances.
Lack of accurate predictions by the model could lead to erroneous conclusions with regard to
fire safety. All results should be evaluated by an informed user.

Throughout this document, the mention of computer hardware or commercial software does not
constitute endorsement by Thunderhead Engineering, nor does it indicate that the products are
necessarily those best suited for the intended purpose.
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Chapter 1. Getting Started

Introduction

PyroSim is an interactive, graphical user interface (or front end) for the Fire Dynamics Simula-
tor (FDS). FDS models can predict smoke, temperature, carbon monoxide, and other substances
during fires. The results of these simulations have been used to ensure the safety of buildings
before construction, evaluate safety options of existing buildings, reconstruct fires for post-acci-
dent investigation, and assist in firefighter training.

FDS is a powerful fire simulator which was developed at the National Institute of Standards and
Technology (NIST) [McGrattan et al., 2007]. FDS simulates fire scenarios using an optimized
approach based on computational fluid dynamics. This approach is very flexible and can be
applied to fires ranging from stove-tops to oil storage tanks. It can also model situations that
do not include a fire, such as ventilation in buildings. FDS and the Smokeview visualization
program are both closely integrated into PyroSim.

The PyroSim interface provides immediate input feedback and ensures the correct format for the
FDS input file. You can work in either metric or English units and you can switch between the two
at any time. In addition, PyroSim offers high-level 2D and 3D geometry creation features, such
as diagonal walls, background images for sketching, object grouping, flexible display options,
as well as copying and replication of obstructions.

The PyroSim 2007 interface, for which this manual is written, supports Version 5 of the Fire
Dynamics Simulator. PyroSim 2006, which supports Version 4 of the Fire Dynamics Simulator,
is still available, as it is anticipated that both versions will be in use during a transition period.

Internet Upgrade/Install

You can download PyroSim from the internet by going to http://www.pyrosim.com/ to obtain
the free trial. If you already have a PyroSim installation, the installer will simply update your
version of PyroSim and leave your license unchanged.

Before installing PyroSim, please ensure that your account has administrator privileges. In addi-
tion, both the user and system must have read/write privileges to the installation directory (typ-
ically C:\Program Files\PyroSim).

To install PyroSim from the internet:

1. Go to the PyroSim web site at: http://www.pyrosim.com/

2. Follow the instructions to download a trial version

3. Once you have downloaded the setup program, double-click on setup.exe

4. Follow the steps in the installer to complete the installation process.

CD Install

If you have a PyroSim CD you can follow these steps to install the software on your computer.
You may also want to read the previous section on upgrading from the internet to ensure that
you have the most up-to-date version of the software.

http://www.pyrosim.com/
http://www.pyrosim.com/
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Before installing PyroSim, please ensure that your account has administrator privileges. In addi-
tion, both the user and system must have read/write privileges to the installation directory (typ-
ically C:\Program Files\PyroSim).

To install PyroSim from a CD:

1. Insert the PyroSim CD into your CD-ROM drive

2. The installation program should start automatically. If it does not, you can launch it manually.
Open the Start menu and click Run..., type D:\setup.exe (where D is the drive letter of
your CD-ROM), then click OK.

3. Follow the steps in the installer to complete the installation process.

Purchase PyroSim   

To enable PyroSim beyond the 30 day trial, you must purchase a license. A full list of purchasing
options can be found at the PyroSim web site. You can purchase PyroSim online or by phone.

Online Purchase

You can purchase PyroSim online with our secure order form at:

https://www.thunderheadeng.com/pyrosim/buy.php

The order form is encrypted and Thunderhead Engineering will not retain your credit card num-
ber. Once the online transaction has been processed you will receive an order number. You can
then email or phone Thunderhead Engineering with your order number and site code(s) and we
will respond with your site key(s). Email is often more convenient because it helps to avoid
communication errors in the site code and site key.

For contact information, please refer to the Contact Us section later in this chapter.

Phone Purchase

Simply call Thunderhead and we will be happy to help you with the purchase. For contact infor-
mation, please refer to the Contact Us section later in this chapter.

Software Registration

When you purchase a license, you will receive a key that enables the software. You must enter this
key in the Register dialog. This dialog also contains your site code which is necessary to generate
the site key. To access the Register dialog from within PyroSim, open the Help menu and click
Register. If your 30 day trial has expired, you can click the Register button on the notification
dialog. The first technique is shown in Figure 1.1 and the second is shown in Figure 1.2. The
Register dialog is shown in Figure 1.3.
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Figure 1.1. Register from the help menu

Figure 1.2. License Expired, Click Register...

Figure 1.3. Registration dialog

To register your copy:

1. Purchase a license to use the software (if necessary)

2. Give us your site code by email or phone, we will respond with your site key.

3. Enter your site key into the registration dialog shown in Figure 1.3

To help prevent errors when sending Thunderhead the site code and when entering the site key,

the Register dialog provides copy and paste buttons. The Copy  button will copy the site code
to the clipboard to allow you to easily paste it in to an email. When you have a site key, you can

copy the key and use the Paste  button to insert the key into the dialog.

Transferring a License

To transfer you license to another computer, you can use the  Remove License dialog.

1. On the Help menu, click Remove License...

2. Click Remove Now and click Yes in the following dialog.
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3. The Confirmation Code box will now contain a number. This number can be used by Thun-
derhead to verify that your license has been terminated. Retain this code and contact Thun-
derhead for a replacement license for the next computer.

PyroSim will exit when you close the Remove License dialog.

Updating PyroSim

To update your copy of PyroSim, simply run the installer for the updated version. Your applica-
tion files will removed and replaced with an updated version and your license will remain intact.

If you purchased a perpetual license for PyroSim and your maintenance period has expired, new
versions of PyroSim will not function with your old license and it will be necessary to reinstall
the old version of PyroSim or purchase an updated license.

Installing a Floating License

A floating (network) license allows multiple users to run PyroSim using a single license. This
feature is only available for users who purchased the floating license feature. The procedure to
install a floating license has the following steps:

1. Install PyroSim on the Server machine

2. Create a network share for the license folder

3. Authorize the Server copy of PyroSim

4. Install PyroSim on the Client computers

5. Configure Client machines to refer to the network share

Server Installation

Install a copy of PyroSim on the network server. This will provide a location for the license files
and security drivers for access by computers on the network.

Note

In order for the floating license system to work properly, the license folder will require
read/write permission for users accessing PyroSim. The PyroSim installer automatically
creates a folder with appropriate permissions in the following default locations:

Windows 2000/XP: C:\Documents and Settings\All Users\Applica-
tion Data\PyroSim\license

Windows Vista: C:\ProgramData\PyroSim\license

You may use another folder as the license folder if desired. You must copy all files from
the default folder to your chosen license folder.

Create a network share for the PyroSim license folder on the server. The users running PyroSim
(as well as the local System account) will require full access to this folder and its network share
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(this is a restriction of the security vendor and can be avoided by running the license server in
a true client/server mode over UDP -- contact support@thunderheadeng.com for more details).
You may want to create a user group for accounts that will have access to PyroSim and grant
that group full control to the directory.

Edit the PyroSim.props configuration file on the Server installation to specify the license
directory. This is set by adding a line with a property named PyroSim.licenseDir to the
end of the file. The property may be set to a UNC share name or mapped drive letter path that
refers to the network share for the PyroSim installation directory. An example property line will
be similar to the following:

PyroSim.licenseDir=\\\\servername\\sharename 

Change servername and sharename to match your configuration. You will need to escape
colons and backslashes with an additional backslash (the example above is for a UNC sharename
\\servername\sharename).

Note

• The PyroSim application must be closed when editing the PyroSim.props file.

• The properties file will not exist if PyroSim has not been run for the first time. You
may create a PyroSim.props text file manually, or run PyroSim once and quit to
create the file.

Server Authorization

After you have set the network license folder in the properties file, run PyroSim on the server and
go to the registration window (Help->Register). You should be presented with a site code.
Email the displayed site code to support@thunderheadeng.com, and a matching Site Key
will be generated for the number of purchased floating licenses. You may close PyroSim while
waiting for the return key via email. After you receive the key, return to the registration window
and enter the new Site Key. You may check the information in Help->About to verify your
license and support duration.

Client Installation

Install a copy of PyroSim on each of the client computers that will access the floating PyroSim
licenses. You do not need to reinstall PyroSim if the client computer already has a trial copy of
PyroSim installed.

Client Configuration

You will also need to add the PyroSim.licenseDir property for each of the client comput-
ers. Use the same network share (or mapped drive) path that was used in the Server properties file.

After the Server copy has been authorized with the network license key, the client copies will
run and decrement the license count based on the license data in the shared network folder. If all
of the licensed copies are in use, a message will appear showing the number of users waiting for
a license. PyroSim will automatically check for an available license at one minute intervals.
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Additional FDS and Smokeview Documentation

In preparing this manual, we have liberally used descriptions from the FDS User's Guide [Mc-
Grattan et al., 2007]. The FDS Users Guide, the FDS Technical Reference, and the Smokeview
Users Guide have been included with PyroSim. Updated documentation and executables for FDS
and Smokeview may be available at: http://fire.nist.gov/fds/.

System Requirements 

PyroSim runs on the Microsoft Windows operating system. You should have at least 256 MB of
system RAM, and a graphics card that supports OpenGL 1.1 or later. A system with at lease 512
MB and a graphics card with at least 64 MB of graphics memory is recommended.

Contact Us 

Thunderhead Engineering
403 Poyntz Avenue, Suite B
Manhattan, KS 66502-6081
USA

Sales Information: sales@thunderheadeng.com
Product Support: support@thunderheadeng.com
Phone and Fax: +1.785.770.8511

http://fire.nist.gov/fds/
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Chapter 2.  PyroSim Basics

PyroSim Interface

PyroSim provides four editors for your fire model: the 3D View, 2D View, Navigation View,
and the Record View. These all represent your current model. If an object is added, removed,
or selected in one view, the other views will simultaneously reflect the change. Each view is
briefly described below.

• Navigation View: This view lists many of the important records in the model. It allows you
to organize your model geometry into groups such as room or sofa. Locating and modifying
records is often faster and easier in this view.

• 3D View: This view shows a 3D representation of your current fire model. You can explore
the model using different view controls. You can also control the appearance of the model
with options like smooth shading, textures, and object outlines. Geometric features can also
be changed.

• 2D View: This view is useful for quickly sketching geometry such as walls and furniture. You
can choose from three viewing planes and perform many useful geometric manipulations.

• Record View: This view gives a preview of the FDS input file that will be generated for the
simulation. It also provides a way to add custom records that will not be processed by PyroSim,
but will be sent to FDS.

Navigation View 

The navigation view is a tree-like view on the left side of the PyroSim main window. An example
of this view in use is shown in Figure 2.1. When you right-click on an item in this view, a list of
the functions PyroSim can perform on that item is shown. To rearrange objects in the Navigation
view, make a selection and then drag the object(s) to the new location.

Figure 2.1. Using the context menu in the Navigation View
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3D View 

Use the 3D view to rapidly obtain a visual image of the model. View navigation options include
typical computer-aided drawing (CAD) controls, Smokeview-like controls, and game-type con-
trols for walking through the view.

3D Orbit Navigation   

To activate the 3D Orbit Navigation controls, select . In this mode the controls are similar to
those used in many computer-aided drawing (CAD) programs.

• To spin the 3D model, select  then left-click on the model and move the mouse. The model
will spin as though you have selected a point on a sphere.

• To zoom, select  (or hold the ALT key) and drag the mouse vertically. Select  then click
and drag to define a zoom box.

• To move the model, select  (or hold the SHIFT key) and drag to reposition the model in
the window.

• To change the focus of the view, select an object(s) and then select  to define a smaller

viewing sphere around the selected objects. Selecting  will reset the view to include the
entire model.

• At any time, selecting  (or typing CTRL + r) will reset the model.

Smokeview-like Controls   

To use the Smokeview-like controls, select View->Use Smokeview-like Navigation. In this
mode:

• Horizontal or vertical mouse movement results in scene rotation about the Z or X axis, respec-
tively.

• With the CTRL key depressed, horizontal mouse movement results in scene translation from
side to side along the X axis. Vertical mouse movement results in scene translation into and
out of the computer screen along the Y axis.

• With the ALT key depressed, vertical mouse movement results in scene translation along the Z
axis. Horizontal mouse movement has no effect on the scene while the ALT key is depressed.

First Person Perspective (Roam) Controls   

To use controls that present the view from the perspective of a person moving through the model,

select  on the toolbar. You can move your eyes to look around in the model, with separate
controls to move your body. This mode can take some experimentation, but once mastered, it
can provide unique views of the model. In Roam mode:
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• To look around the 3D model, left-click on the model and move the mouse. You are looking
with your eyes in the direction of the mouse.

• With the CTRL key depressed, vertical mouse motion moves you forward (or backward) into
the model. Horizontal mouse motion moves you to the left or right.

• With the ALT key depressed, vertical mouse motion moves you up (or down) relative to the
model.

• the Scroll Wheel increases or decreases your field of view. If you do not have a Scroll Wheel,

use the Zoom tool .

Figure 2.2 shows the view of a model from outside, and Figure 2.3 shows the view after going
into the model and looking up towards the roof (PyroSim model by John McKinney).

Figure 2.2. Exterior view of model
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Figure 2.3. Interior view of model looking at roof and bleachers

2D View   

The 2D view provides a projected 2D view of the model. The 2D view controls are similar to
those in the 3D View.

• The 2D model viewing direction  can be changed by selecting: top  , front  , or side 
views. The default 2D View is the top view.

• To zoom, select  (or hold the ALT key) and drag the mouse vertically. Select  then click
and drag to define a zoom box.

• To move the model, select  (or hold the SHIFT key) and drag to reposition the model in
the window.

• To change the focus, select an object(s) and then select  . Selecting  will reset the display
to include the entire model.

• At any time, selecting  (or typing CTRL + r) will reset the model.

Snapshots of Display   

Images of the current display can be saved to a file by opening the File menu and clicking Snap-
shot.... The user can specify the file name, image type (png, jpg, tif, bmp), and the resolution. A
good choice is the Portable Network Graphics (png) type and Medium resolution.

Preferences 

Several options for running of PyroSim can be set in the Preferences dialog, Figure 2.4. These
preferences will be recalled the next time PyroSim is started.
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The Format FDS file for easy reading option is used to control the format of the FDS input file
written by PyroSim. By default, the file is formatted to be easily readable. However, this means
that some precision is lost. The full precision can be obtained by unselecting this option.

The FDS Execution options allow you to specify the FDS and Smokeview executables that are
used by PyroSim.

The Run Smokeview when FDS simulation completes option is used to automatically show
results after running an FDS simulation.

The Hardware Drawing Options give control over the amount of graphics card hardware ac-
celeration used when drawing the model. If there are display problems, the user should disable
the two Hardware acceleration options.

Figure 2.4. The preferences dialog

Units 

Models can be created in either English or Metric units. To select a system of units, on the View
menu, click Units, then click the desired unit. PyroSim will automatically convert your previous
input values into the unit system you select. The Record View will always display values in the
appropriate FDS units, regardless of what unit system you choose to work in.

Color Schemes 

To select a Default, Black Background, White Background, or Custom color scheme, on the
View menu, click Color Scheme. The custom color scheme is defined in the PyroSim.props file
in the PyroSim installation directory (usually C:\Program Files\PyroSim).

To define a custom color scheme:

1. Close PyroSim

2. Edit the PyroSim.props file
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3. Change the following default colors to the colors you wish:

          Colors.Custom.axis=0xffff00
          Colors.Custom.axis.box=0x404040
          Colors.Custom.axis.text=0xffffff
          Colors.Custom.background=0x0
          Colors.Custom.boundary.line=0xffffff
          Colors.Custom.grid=0x4d4d66
          Colors.Custom.group.highlight=0xffff00
          Colors.Custom.heatDetector=0xff0000
          Colors.Custom.obst=0xff0000
          Colors.Custom.obst.highlight=0xb2b200
          Colors.Custom.origin2D=0x737373
          Colors.Custom.smokeDetector=0xff00
          Colors.Custom.snap.point=0xff00
          Colors.Custom.snapto.grid=0x404040
          Colors.Custom.snapto.points=0xc0c0c0
          Colors.Custom.sprk=0xff
          Colors.Custom.text=0xffffff
          Colors.Custom.thcp=0xffff00
          Colors.Custom.tool=0xff00
          Colors.Custom.tool.guides=0x7c00
         

4. Save the edited PyroSim.props file

5. Restart PyroSim
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Chapter 3. Working with Files

Several files are used when performing a fire analysis using PyroSim. These include the PyroSim
model file, the FDS input file, and FDS output files. This section describes how to load and save
files in the formats supported by PyroSim.

Creating a New PyroSim Model  

When PyroSim is started, it begins with an empty model. You can close the current model and
create a new empty model by opening the File menu and clicking New. PyroSim always has one
(and only one) active model.

Saving a PyroSim Model   

The PyroSim model file (.psm) is stored in a binary format that represents a PyroSim model. The
PyroSim model contains all the information needed to write an FDS input file, as well as addi-
tional information such as obstruction grouping, floor heights, background images, and textures.
This format is ideal for sharing your models with other PyroSim users.

To save a new model:

1. On the File menu, click Save.

2. Enter the file name and click the Save button.

Open a Saved PyroSim Model  

PyroSim model files have a .psm extension. To open a saved model:

1. On the File menu, click Open....

2. Select the file and click the Open button.

A list of recently opened files is also available. To open recent files, on the File menu, click
Recent PyroSim Files, then click the desired file.

PyroSim has an auto-save feature which stores a copy of your current model every 10 minutes.
This file is automatically deleted if PyroSim exits normally, but if PyroSim crashes, you can
recover your work by opening the autosave file. It can be found either in the same directory as
your most recent .psm file, or in the PyroSim installation directory if your model was unsaved.

For more information about opening files saved with previous versions of PyroSim, please refer
to Appendix A.

Importing FDS Models   

PyroSim allows you to import existing FDS input files. When you import an FDS file, PyroSim
will create a new PyroSim model from the imported file. During import, PyroSim will check for
the validity of each record. If errors are detected, you will be notified. You may then make the
required corrections and attempt to import the file again.
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To import existing FDS models into PyroSim:

1. On the File menu, click Import, then click FDS File....

2. Select the FDS file and click Open.

PyroSim supports file import for versions 4 and 5 of FDS. For more information about opening
files compatible with version 4 of FDS, please refer to Appendix A.

Exporting FDS Models   

PyroSim also allows you to explicitly export the current model to an FDS input file. You can
manually edit the file to take advantage of advanced FDS features, or to easily transfer the input
file to a different machine or special version of FDS.

To export an FDS file:

1. On the File menu, click Export, then click FDS File....

2. Enter the file name and click Save.

The file exported by PyroSim will be compatible with version 5 of FDS.

Import DXF Files   

To import DXF geometry into your PyroSim model, you can use the Import DXF dialog.

1. On the File menu, click Import, then click Import DXF....

2. Select a DXF or zipped DXF file to import.

3. Specify units, layers, and other settings.

4. Click OK.

Convert Solid Geometry

PyroSim will only generate FDS geometry for lines, polylines, and faces. Other entities present
in the DXF file will be ignored. In particular, any 3D solid geometry in a DXF input file will not
be imported. To transfer a 3D solid AutoCAD model into PyroSim, you must first decompose
the solid entities into 3D faces. You can do this using the explode command in AutoCAD.

Some solid AutoCAD geometry cannot be readily decomposed with the explode command. In
this case, you can use the following procedure to decompose the solid object into faces.

1. Select the objects you wish to export to PyroSim. The ALL command will select everything.

2. Export the selected objects to the 3D studio file format with the 3DSOUT command

3. In the 3D Studio File Export Options dialog, select the following options:

• For Derive 3D Studio Objects From, select AutoCAD Object Type
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• For Smoothing, select Auto-Smoothing and 30 degrees

Then click OK to export the objects

4. Open a new drawing, then import the objects using the 3DSIN command

5. The objects will be imported as polyface meshes. Use the explode command on the meshes
to create 3D faces.

6. Save this new drawing as a DXF file

DXF Import Dialog

The following sections describe the major elements of the Import DXF dialog.

Layers

If your DXF input file has been organized into layers, you can control which layers are imported
using the list on the left hand side of the Import DXF dialog. All of the layers in the file will be
initially selected, but you can instruct PyroSim to ignore particular layers by deselecting them
in the list. As you select and deselect layers, the 3D preview window will display the items that
will be imported. Deselecting a layer will have no effect on the imported background image.

Length Unit

PyroSim will scale and orient the obstructions and background image generated from your DXF
file based on your selection of a length unit. It is very important that you specify the length unit
because this information cannot be inferred from the DXF file and it will control the location
and size of all imported geometry.

To specify the length unit:

1. In the Import DXF dialog, click the Units list.

2. Click the unit of length used in your DXF file.

The 3D preview window will be automatically updated to reflect the selected length unit.

Settings

The DXF Import Preferences dialog allows you to control what information PyroSim will ex-
tract from the DXF file. To access this dialog, click the Settings... button in the Import DXF
dialog.

The General tab provides the following options:

• Import Colors Select this option to apply the color of an imported DXF entity to the corre-
sponding PyroSim geometry object(s).

• Import Empty Layers Select this option to create groups in PyroSim for layers that don't
contain any importable entities.
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• Import Background Image Select this option to create a 2D image of the imported DXF
file and add this image to the current model as a Floor. The position and visibility of the
background image can be edited later using the Configure Background Image dialog.

• Default Wall Width Edit this value to control the width of walls generated from 2D DXF
entities.

• Default Wall Height Edit this value to control the height of walls generated from 2D DXF
entities.

The length unit used to control wall width and height will be the same as specified in the Import
DXF dialog. Note that this is not necessarily the same unit as your PyroSim model. PyroSim will
automatically convert from the DXF unit to the model length unit.

The Entities tab provides the following options:

• Import LINEs Select this option to convert LINE entities in your DXF file to wall objects in
your PyroSim model. The height and width of the imported walls is set by the corresponding
entries in the General tab.

• Import LWPOLYLINEs Select this option to convert LWPOLYLINE entities in your DXF
file to wall objects in your PyroSim model. The height and width of the imported walls is set
by the corresponding entries in the General tab.

• Import 3DFACEs (Beta) Select this option to convert 3DFACE entities in your DXF file
to convex polygon objects in your PyroSim model. Models with many faces require a large
amount of memory. If you reach the memory limit, you can break the AutoCAD model into
parts. These parts can then be separately imported and merged in PyroSim.

Using these options, PyroSim will create 3D solid geometry suitable for use with FDS from the
entities defined in your DXF file. Once these entities have been imported, you can use PyroSim
to edit the resulting objects.
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Chapter 4. Meshes 

Working with Meshes

All FDS calculations are performed within computational meshes. Every object in the simulation
(e.g. obstructions and vents) must conform to the mesh. When an object's location doesn't exactly
conform to a mesh, the object is automatically repositioned during the simulation. Any object
that extends beyond the boundary of the physical domain is cut off at the boundary. There is no
penalty for defining objects outside of the domain, but these objects do not appear in Smokeview.

To achieve optimal simulation accuracy, it is important to use mesh cells that are approximately
the same size in all three directions.

FDS uses a Poisson solver based on Fast Fourier Transforms (FFTs). A side effect of this ap-
proach is that optimal mesh divisions are constrained to the form 2^u 3^v 5^w, where u, v and
w are integers. For example, 64 = 2^6, 72 = 2^3 * 3^2, and 108 = 2^2 * 3^3 are good mesh
dimensions. However, 37, 99 and 109 are not. In addition, using a prime number of cells along an
axis may cause undesirable results. PyroSim warns when the number of divisions is not optimal.

Uniform Meshes

This example illustrates creating a multiple mesh model. To create the first mesh:

1. On the Model menu, click Edit Meshes... .

2. Click New

3. In the Max X box, type 5.0, in the Max Y box, type 1.0, and in the Max Z box, type 1.0.

4. In the X Cells box, type 50, in the Y Cells box, type 10, and in the Z Cells box, type 10.

5. Click OK.
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Figure 4.1. Defining properties of the new mesh

The 3D View will now display the resulting mesh.

Nonuniform Meshes

To create a second, nonuniform mesh:

1. On the Model menu, click Edit Meshes....

2. Click New

3. In the Min X box, type 0.0, in the Min Y box, type 1.0, and in the Min Z box, type 0.0

4. In the Max X box, type 1.0, in the Max Y box, type 3.0, and in the Max Z box, type 1.0

5. In the Division method box, select Non-Uniform

6. In the table, enter the data shown in Table 4.1

7. Click OK

Table 4.1. Non-Uniform Mesh Parameters

 Dir (X,Y,Z) Num Cells Size

X 10 0.1

Y 10 0.1

Y 5 0.2

Z 10 0.1
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Figure 4.2. Defining properties of the nonuniform mesh

You can click  (or type Ctrl + R) to reset the model. The resulting meshes are displayed below.

Figure 4.3. 3D display of first and second mesh

Using Multiple Meshes

The term "multiple meshes" means that the computational domain consists of more than one
rectangular mesh, usually connected, although this is not required. In each mesh, the governing
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equations can be solved with a time step based on the flow speed within that particular mesh.
Some reasons for using multiple meshes include:

• Multiple meshes are required for parallel processing of FDS.

• If the geometry of the problem has corridors such as shown in Figure 4.3, using multiple
meshes can significantly reduce the number of cells and the solution time.

• Because each mesh can have different time steps, this technique can save CPU time by requir-
ing relatively coarse meshes to be updated only when necessary. Coarse meshes are best used
in regions where temporal and spatial gradients of key quantities are small or unimportant.

Meshes can overlap, abut, or not touch at all. In the last case, essentially two separate calculations
are performed with no communication at all between them. Obstructions and vents are entered
in terms of the overall coordinate system and need not apply to any one particular mesh. Each
mesh checks the coordinates of all the geometric entities and decides whether or not they are
to be included.

As described in the FDS 5 User Guide ([McGrattan et al., 2007]), the following rules of thumb
should also be followed when setting up a multiple mesh calculation:

• Mesh Alignment

The most important rule of mesh alignment is that abutting cells ought to have the same cross
sectional area, or integral ratios, as shown in Figure 4.4

• Mesh Priority

In general, the meshes should be entered from finest to coarsest. FDS assumes that a mesh
with higher priority has precedence over a mesh with a lower priority if the two meshes abut
or overlap.

• Mesh Boundaries

Avoid putting mesh boundaries where critical action is expected, especially fire. Sometimes
fire spread from mesh to mesh cannot be avoided, but if at all possible try to keep mesh in-
terfaces relatively free of complicating phenomena since the exchange of information across
mesh boundaries is not as accurate as cell to cell exchanges within one mesh.

• Data Exchange

Information from other meshes is received only at the exterior boundary of a given mesh.
This means that a mesh that is completely embedded within another receives information at
its exterior boundary, but the larger mesh receives no information from the mesh embedded
within. Essentially, the larger, usually coarser, mesh is doing its own simulation of the scenario
and is not affected by the smaller, usually finer, mesh embedded within it. Details within the
fine mesh, especially related to fire growth and spread, may not be picked up by the coarse
mesh. In such cases, it is preferable to isolate the detailed fire behavior within one mesh, and
position coarser meshes at the exterior boundary of the fine mesh. Then the fine and coarse
meshes mutually exchange information.
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• Boundary Obstructions

If a planar obstruction is close to where two meshes abut, make sure that each mesh "sees"
the obstruction. If the obstruction is even a millimeter outside of one of the meshes, that mesh
may not account for it, in which case information is not transferred properly between meshes.

• Parallel Calculation

In a parallel calculation, it is recommended that the time steps in all meshes to be the same.
This is the default setting in PyroSim and FDS 5 and provides a tighter connection between
meshes. This option is selected by the Synchronize time step for tighter connection between
meshes checkbox on the Edit Meshes dialog.

• Trial and Error

Experiment with different mesh configurations using relatively coarse mesh cells to ensure
that information is being transferred properly from mesh to mesh. There are two issues of
concern. First, does it appear that the flow is being badly affected by the mesh boundary? If
so, try to move the mesh boundaries away from areas of activity. Second, is there too much of
a jump in cell size from one mesh to another? If so, consider whether the loss of information
moving from a fine to a coarse mesh is tolerable.
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This is the ideal kind of
mesh to mesh alignment.

This is allowed so long as
there are an integral number
of fine cells abutting each
coarse cell.

This is allowed, but of ques-
tionable value. PyroSim will
warn if meshes overlap.

This is no longer allowed
in FDS 5.1 and higher. Py-
roSim will warn against this
mesh alignment.

Figure 4.4. Correct and incorrect mesh alignment

2D View Drawing Grid  

If you create a solution mesh before creating any geometric objects, then that mesh will be used by
default when drawing objects in the 2D View. However, you can also define a separate drawing
grid (or sketch grid) in the 2D View. This can be useful if the geometry of your model will extend
beyond the bounds of the solution mesh, or if you want your objects to be defined using a finer
geometric resolution than will be used for the solution.

The 2D View drawing grid has several options that you can modify:
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• To view the sketch grid, on the View menu, highlight Select Grid and click sketch grid.

• To specify the size of the cells in the Sketch Grid:

1. On the View menu, click Set Sketch Grid Spacing....

2. Enter the distance you want between each point on the sketch grid and click OK.

• To toggle the grid display, on the View menu, click Show Grid.

• To toggle the "Snap-to" Points, on the View menu, click Show Snap-to Points.

• To toggle cursor snapping to grid points, on the View menu, click Snap to Grid.

Modeling Hint: In FDS the spatial resolution of the solution is defined by the solution mesh(es),
not the Sketch Grid. Using the solution mesh for 2D View drawing ensures that the model ge-
ometry matches the FDS solution geometry and is the recommended approach. Some users cre-
ate all model objects using mesh dimensions. While this leads to a "blocky" appearance, it does
represent the true solution geometry and ensures there will be no unexpected gaps in the model.
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Chapter 5. Materials 

To simulate a surface made of heat-conducting solids or a fuel you must specify a material that
describes certain thermal properties and pyrolysis behavior. PyroSim offers two categories of
materials: solid materials and liquid fuels.

To create a new material, you can use the Edit Materials dialog. On the Model menu, click
Edit Materials....

Solid Materials

Examples of solid materials include brick, gypsum board, and upholstery. To create a solid ma-
terial:

1. In the Edit Materials... dialog, click New...

2. In the Material Name box, type the name of the new material

3. In the Material Type box, select Solid

4. Click OK

After following these steps, a default solid material will be created. Text entered in the Descrip-
tion box will not affect the simulation, but will preserved in the FDS input file using the FYI
field of the material. Including a description of the material is recommended.

The Thermal Properties tab provides the following options:

Parameter Description

Density The material's density.

Specific Heat The material's specific heat. Specific heat can be specified as
a function of temperature.

Conductivity The material's heat conductivity. Conductivity can be speci-
fied as a function of temperature.

Emissivity The material's emissivity. A value of 1.0 indicates that this
material will radiate no energy. Lower values indicate that the
material will radiate more energy.

Absorption Coefficient This coefficient refers to the depth over which thermal radia-
tion can be absorbed.

The Pyrolysis tab provides options to set the heat of combustion and add reactions that will be
used to govern how the material burns. Each material can have a maximum of 10 reactions. To
add a reaction, click Add.... This will open a dialog to edit the new reaction. It provides the
following options:

On the Rate tab:

Parameter Description

Achieve reaction rate of The reaction rate at a given temperature.
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Parameter Description

at The temperature at which the given reaction rate will occur.

A (Pre-exponential Factor) (parameter shown in equation)

E (Activation Energy) (parameter shown in equation)

Mass Fraction Exponent (parameter shown in equation)

Exponent (parameter shown in equation)

Value (parameter shown in equation)

On the Byproducts tab:

Parameter Description

Heat of Reaction Heat yield of this reaction. This must be a positive number.

Endothermic/Exothermic Specifies if the heat yield is endothermic or exothermic.

Fuel Vapor Yield The mass fraction of yield that will become fuel vapor.

Water Vapor Yield The mass fraction of yield that will become water vapor.

Residue Yield The mass fraction of yield that will become residue. If there is
only one material defined in PyroSim, this option will not be
available.

Residue The material that will be used to represent the residue. If there
is only one material defined in PyroSim, this option will not
be available.

Liquid Fuels

Examples of liquid fuels include kerosene and ethanol. To create a liquid fuel:

1. In the Edit Materials... dialog, click New...

2. In the Material Name box, type the name of the new material

3. In the Material Type box, select Liquid Fuel

4. Click OK

After following these steps, a default solid material will be created. Text entered in the Descrip-
tion box will not affect the simulation, but will preserved in the FDS input file using the FYI
field of the material. Including a description of the material is recommended.

The thermal properties tab for liquid fuels is identical to the thermal properties tab solid fuels
(see Section ).

The Pyrolysis tab provides the following parameters:

Parameter Description

Heat of Vaporization Heat yield when this liquid fuel is converted to gas. This must
be a positive number.
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Parameter Description

Endothermic/Exothermic Specifies if the heat yield is endothermic or exothermic.

Fuel Vapor Yield The mass fraction of yield that will become fuel vapor.

Water Vapor Yield The mass fraction of yield that will become water vapor.

Residue Yield The mass fraction of yield that will become residue. If there is
only one material defined in PyroSim, this option will not be
available.

Residue The material that will be used to represent the residue. If there
is only one material defined in PyroSim, this option will not
be available.
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Chapter 6. Surfaces   

Surfaces are used to define the properties of solid objects and vents in your FDS model. The
surface can use previously defined materials in mixtures or layers. By default, all solid objects and
vents are inert, with a temperature that is fixed at the ambient temperature (set in the Simulation
Parameters dialog. In addition to defining heat conduction in a solid, surfaces can also be used
to define a burner, specify the ignition temperature for an object, give a vent an supply velocity,
and set the many other properties supported by FDS.

To create, modify, and delete surfaces, you can use the Edit Surfaces dialog. To open the surface
manager dialog, on the Model menu, click Edit Surface Properties.... The dialog shown in
Figure 6.1 shows the dialog being used to edit an upholstery surface.

Figure 6.1. The Edit Surfaces dialog

Reserved Surfaces

There are four fundamental or "reserved" surface types: ADIABATIC, INERT, MIRROR, and
OPEN. These surfaces cannot be changed and are present in every analysis.

ADIABATIC

This surface remains fixed at the ambient temperature. There is no heat transfer (radiative or
convective) from the gas to an adiabatic solid.

INERT

This surface remains fixed at the ambient temperature. Heat transfer does occur from gases to
INERT surfaces. This is the default surface in PyroSim.
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MIRROR1

This surface is used only for vents on the exterior grid boundary. A MIRROR is a no-flux, free-
slip boundary that reverses flow. It is intended to be applied to an entire grid boundary to sym-
metrically double the size of the domain.

OPEN1

This surface is used only for vents on the exterior grid boundary. OPEN denotes a passive opening
to the outside and is often used to model open doors and windows.

Surface Types

PyroSim aids the user by organizing the surface options into logical types, such as a burner to
define a simple fire or a layered surface to represent a solid, heat conducting wall. The available
surface types are described below.

Adiabatic

This surface type is identical to the built-in ADIABATIC surface type. It allows you to customize
the description, color, and texture of the adiabatic surface described in Section .

Inert

This surface type is identical to the built-in INERT surface type. It allows you to customize the
description, color, and texture of the inert surface described in Section .

Burner

This surface type represents a fire with a known heat release rate2 or mass (fuel) loss rate.

Parameters for burner fires are arranged in two groups: heat release and particle injection. Heat
release options:

Parameter Description

Heat Release

Heat Release Rate (HRR) The heat release rate per unit area of this burner.

Mass Loss Rate The mass loss rate per unit area of this burner.

Ramp-Up Time At the beginning of the simulation, this surface will not be
burning. This field allows you to describe how the heat re-
lease ramps up from ambient to the specified value.

1Vents of this type should not be toggled (deactivated or activated) during the simulation.
2The heat release rate for a burner surface is specified per unit area. A surface with a 500 kW/m2 heat release rate applied to a 2.0
m2 vent would result in a 1000 kW fire.
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Parameter Description

Extinguishing Coefficient This parameter governs the suppression of the fire by wa-
ter. For more information, see section 10.7 of the FDS users
guide.

Temperature

Surface Temperature The surface temperature of this burner. The value TMPA rep-
resents ambient temperature.

Convective Heat Flux The heat flux per unit area at the surface.

Ramp-Up Time This field allows you to describe how the temperature ramps
up from ambient to the specified value.

Other

Emissivity This parameter controls how the surface radiates heat. Using
a value of 1.0 makes this surface a black body. Lower values
increate the amount of radiated heat.

Particle injection options:

Parameter Description

Emit Particles Enable this option to emit particles from the surface.

Particle Type Select a particle to emit. To create a new particle, click the
Edit Particles... button.

Number of Particles per Cell Controls the number of particles inserted per second. A value
of 1 will insert one particle per grid block per second.

Mass Flux For particles that have mass, this option provides an alternate
way to control the number of particles inserted per second.

Heater/Cooler

This surface type represents a radiative heat source. The options are identical to the options for
a burner without the heat release options. If the surface temperature is less than the ambient
temperature, the surface will remove heat from the surrounding gases.

Supply

This surface represents a vent that injects air into the simulation domain. The parameters for
supply surfaces are arranged in 4 groups: air flow, temperature, species injection, and particle
injection.

Air flow options:

Parameter Description

Specify Velocity Use a constant velocity to define air movement through the
vent.

Specify Volume Flux
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Parameter Description

Use a constant volume flux to define air movement through
the vent.

Specify Mass Flux Use a constant mass flux to define air movement through the
vent.

Specify ... Individual Species Define air movement through the vent using a table of extra
species and their mass fluxes. This method requires a model
that includes extra (non-reactive) species. Flux data is speci-
fied on the Species Injection tab.

Tangential Velocity The tangential velocity of the air flow. The first parameter is
the velocity in the x or y direction and the second parameter
is in the y or z direction, depending on the normal direction of
the vent. An example of tangential velocity is shown in Fig-
ure 6.2.

Slip Factor The slip factor affects the calculation of velocity at the walls.
To specify a no-slip boundary condition, use -1. To specify a
free slip boundary condition, use 1. Values between -1 and 1
represent partial slip conditions.

Ramp-Up Time At the beginning of the simulation, vents with this surface
will not be blowing. This parameter controls the time it takes
to ramp the air flow up to the specified amount.

Wind Profile The default wind profile is constant (Top Hat), to model
wind conditions outdoors there are two additional options:
parabolic and atmospheric. Parabolic produces wind with
a parabolic profile whose maximum is the specified velocity.
Atmospheric produces a wind profile of the form u=u0(z/
z0)^p.

Atmospheric Profile Exponent The term p in the atmospheric profile equation. This option is
only available when atmospheric profile is selected.

Atmospheric Profile Origin The term z0 in the atmospheric profile equation. This option
is only available when atmospheric profile is selected.
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Figure 6.2. A simulation demonstrating affect of the normal axis on the direction of tangential
velocity.

The temperature of the air injected by supply vents can be controlled using the following options:

Parameter Description

Surface Temperature The temperature of the injected air. The value TMPA repre-
sents ambient temperature.

Convective Heat Flux The heat flux per unit area at the surface.

Ramp-Up Time This field allows you to describe how the temperature ramps
up from ambient to the specified value.

Other

Emissivity This parameter is not used for supply surfaces.

The species injection options are available if the Specify Mass Flux of Individual Species op-
tion in the Air Flow group is selected and there are extra, non-reactive species present in the
simulation.

Particle injection options:

Parameter Description

Emit Particles Enable this option to emit particles from the surface.

Particle Type Select a particle to emit. To create a new particle, click the
Edit Particles... button.

Number of Particles per Cell Controls the number of particles inserted per second. A value
of 1 will insert one particle per grid block per second.

Mass Flux For particles that have mass, this option provides an alternate
way to control the number of particles inserted per second.
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Exhaust

Exhaust surfaces can be used to remove gas from the simulation domain. The specification of
their air movement parameters is identical to that of a supply surface, but instead of the velocity
or flux driving air into the domain, they are pulling air out.

Fan

A fan is a special type of surface that more accurately simulates a fan than a supply surface. Fans
must be attached to a thin obstruction that separates two pressure zones. For more information
about fans, please refer to section 8.3.2 of the FDS users guide.

Layered

Layered surfaces are composed of one or more material definitions. Materials include solid and
liquid substances such as concrete, pine, and ethanol. For more information about materials and
how they can be specified in PyroSim, please refer to Chapter 5. This type of surface is ideal for
walls and other objects that are composed of real-world materials. This surface type can also be
used to inject extra (non-reactive) species into the simulation.

Layered surfaces have four groups of options: material layers, reaction, species injection, and
particle injection. The material layers group contains the following options:

Parameter Description

Initial Internal Temperature The initial temperature within this surface.

Backing The backing of a surface is the boundary condition behind
the surface. The default value, Air Gap represents an air
gap, Exposed will allow the surface to transfer heat into the
space behind the wall, and Insulated prevents any heat
loss from the back of the material.

Gap Temperature The temperature of air in the air gap. This option is only
available when the Air Gap backing type is selected.

Temperature Ramp This field allows you to describe how the temperature ramps
up from ambient to the specified value.

Material Layers

Thickness The thickness of this material layer.

Material Composition Within a layer (row), you can specify multiple materials
based on mass fraction. For example, to specify a layer that
is just brick, type 1.0 BRICK (assuming you have created a
material called BRICK). To specify a layer of wet brick, you
could enter 0.95 BRICK; 0.05 WATER. Each material is
separated by a semi-colon.

Edit Click to specify the materials in this layer using an alternate
table UI.
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The reaction used to model a given surface can either be taken from the material specifications,
or given explicitly by the surface. Manually specifying the parameters will produce a surface
similar to a burner. You can edit this behavior using the reaction options:

Parameter Description

Governed by Material This surface's reaction will be controlled by the materials that
it is constructed from.

Governed Manually Override the default reaction behavior for this surface and
specify the following parameters.

Heat Release Rate The heat release rate per unit area of this surface.

Mass Loss Rate The mass loss rate per unit area of this surface.

Ramp-Up Time This field allows you to describe how the heat release ramps
up from ambient to the specified value.

Extinguishing Coefficient This parameter governs the suppression of the fire by wa-
ter. For more information, see section 10.7 of the FDS users
guide.

Burn Immediately Select this option to create a surface that is initially burning.

Ignite at Select this option to create a surface that will begin burning at
a specified temperature.

Heat of Vaporization Heat yield when this fuel is converted to gas.

Allow ... burn away Surfaces of this type can be removed from the simulation af-
ter expending all available fuel.

You can inject extra (non-reactive) species into the simulation using the species injection options.
To use these options, you must first specify extra species using the Edit Extra Species dialog.
You can edit the following extra species options:

Parameter Description

Inject by Mass Fraction Select this option to specify species injection using mass frac-
tions.

Inject by Mass Flux Select this option to specify species injection using mass flux.

Mass Flux of Background
Species

The background species (default=AIR) mass flux into the do-
main.

Background Species Ramp This field allows you to describe how the injection rate ramps
up from zero to the specified value.

Species This value cannot be edited. It displays the name of one of the
species selected in the Edit Extra Species dialog.

Mass Fraction The mass fraction of an extra species to inject. This option is
only available if Inject by Mass Fraction is selected.

Mass Flux The mass flux of an extra species to inject. This option is only
available if Inject by Mass Flux is selected.

Ramp-Up Type This field allows you to describe the function used to ramp up
the injection rate from zero to the specified value.
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Parameter Description

Ramp Value The time it takes to achieve the specified injection rate.

The particle injection parameters for layered surfaces are identical to those for burners.
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Chapter 7. Geometry (Basic Concepts) 

PyroSim provides tools to help the user rapidly create model geometry. The 2D View is the fastest
way to create a building model. The user can organize the model by floors, import a background
image for each floor, and then sketch the walls of the building on top of the background image.
PyroSim includes support for diagonal walls.

More complex geometry, such as curved walls and domes, can be created using the Block Tool
or Wall Tool, as described in the chapter on Creating Complex Geometry.

Obstructions 

Obstructions are the fundamental geometric representation in FDS. Obstructions are rectangular
solids defined by two points. Surface properties are assigned to each face of the obstruction.
Activation events can be defined to create or remove an obstruction during a simulation.

The geometry of an obstruction does not need to match the geometry of the grid used for the
solution. However, the geometry can only be resolved to the grid. At the time of analysis, all
faces of an obstruction are shifted to correspond to the nearest grid cell. Thus, some obstructions
may become thicker in the analysis; others may become thin and correspond to a single cell
face which has the potential to introduce unwanted gaps into a model. These ambiguities can be
avoided by making all geometry correspond to the grid spacing.

In most cases, the user will use the 2D View Obstruction Tool or the Wall Tool to rapidly
sketch new obstructions. To directly create an obstruction using a dialog:

1. On the Model menu, click New Obstruction..., or on the toolbar, click .

2. Enter the obstruction data on the Specification tab.

Figure 7.1. Obstruction dialog
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The user provides the Description name, selects a group for the new obstruction (see the follow-
ing section on grouping), gives the geometry, and assigns previously created surface properties.

Other options include:

• The color. If no color is specified, then the surface colors are used. Specifying a color for the
obstruction overrides surface colors.

• Unselecting the "Sawtooth" option is useful for smoothing the flow around an object, such a as
a curved wall, that has been represented using many rectangular obstructions ("stair stepping").
When "Sawtooth" is not selected, vorticity is prevented at the corners of the obstruction. By
default, "Sawtooth" is selected.

• "Thicken" ensures that if the obstruction is smaller than the grid dimension it will be made
larger rather than collapsed to a plane.

• "Permit Holes" allows holes to remove all or part of the obstruction from the model.

Obstructions can be created or removed during a simulation. On the Activation Events tab, the
user can specify time or device-based events that will cause the object to be removed or added to
the simulation. You must define the devices before they can be used for obstruction activation.

Figure 7.2. Defining obstruction activation events

To configure a time-based activation event, enter a time in the table and select an activation or
deactivation event. In this context, activating the object will make it appear in the simulation
domain, and deactivating the object will remove it. Time events can be useful to augment the
fire simulation with phenomenon that can otherwise not be modeled. For example, if you know
the time at which a window breaks, you can cause a pane of glass to be initially present, and at
a prescribed time remove that pane of glass from the simulation.
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If a model contains detector devices or scalar quantity output devices, additional options will be
available. By checking the Enabled box for a detector, the activation state of the obstruction will
track the activation state of the device. Scalar quantity output devices function in a similar way,
but you must specify a Value trigger for activation.

The custom option will only be selected if you have imported a model that defines a control
function for the current object that is more complicated than those that can be represented by this
dialog. PyroSim will still write the correct control function to the FDS input file, but you will
not be able to edit it via the user interface.

Using Groups to Organize a Model 

A key concept is the organization of the model into hierarchical groups of objects. The "Model"
is the base group. Groups can be nested inside other groups, which allows the user to work with
thousands of objects in an organized way. When an action is performed on a group, that action
will be propagated to all objects in the group.

Organizing a Building Model by Floors 

By default, a new model has one floor 3 m (9.84 feet) high. To define the floors in your model,

go to the 2D or 3D View and select the Define Floor Locations tool ( ). This will display the
Manage Floors dialog. In this example, two floors have been created, with each being 10 feet tall.

Figure 7.3. Defining floors in a model

Once the floors have been defined, the user can filter the display to show either a single floor
or all floors.
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Figure 7.4. Select a floor to display

Modeling Hint: If your model has floors, we recommend creating corresponding floor groups
(Floor 1, Floor 2, etc.). Then, as the building is drawn, make sure that the objects are placed in
the matching group. This will help organize your model.

Adding a Background Image to a Floor 

Each floor can have an associated background image. To add a background image to a floor, go
to the 2D or 3D View, select a specific floor, then select the Configure Background Image tool

 (alternately select the Define Floor Locations tool, , and then in the Background Image
column, select the Edit button). This will display the Configure Background Image dialog. You
will be guided through the following steps:

• Choose a background image file. Valid image formats are bmp, dxf, gif, jpg, png, tga, and tif.

• Specify the Anchor Point for the image by clicking on the image. The Anchor Point is a point
on the image at which the coordinates are specified in the model coordinate system. The model
coordinates of the anchor point are not required to be at the origin.

• Set the model scale. Select the Choose Point A button, then select the first point that will be
used to define a length. Select the Choose Point B button and select the second point to define
a length. Input the Distance between points A and B.

• Use the sliding scale to change the image brightness.

• Select OK to close the Configure Background Image dialog.



Geometry (Basic Concepts)

39

Figure 7.5. Display of background image

Now, in the 2D View, when the user displays a specific floor, the background image will be
displayed. In the 3D View all background images will be displayed. To turn off the background
images, go to the 2D or 3D View, and toggle View->Show Background Images.
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Chapter 8. Tools for Creating Geometry

PyroSim is designed to help you interactively create complex geometry. The 2D View provides
a collection of geometry creation tools. These tools allow you to quickly draw rectangular ob-
structions, angled walls, grid blocks, vents, and rooms. Several of these tools have an analog that
creates holes instead of solid obstructions. All geometry creation tools are located on the toolbar
at the left side of the 2D View.

Some of these tools allow you to create and edit objects that are not constrained to the FDS
grid. In these cases, PyroSim will automatically convert the shapes to grid-based blocks when
the FDS input file is created. You can also preview these bocks by clicking View, then selecting
Preview as Blocks.

All of the geometry tools in this chapter are fully supported by the undo/redo system. If you
change your mind about the placement of an object you have just created, just click Edit, then
click Undo.

Most objects can be edited with the Selection  tool. This tool is located in the toolbar above
the 2D and 3D views. Once you have activated the Selection tool, click on the object you would
like to modify. Blue nodes or handles will appear on the object where it can be modified. By
dragging these handles you can quickly make changes to the existing object.

You can edit the settings for any tool by clicking the Tool Properties  button located at the
bottom of the toolbar. Options such as initial surface type, color, sawtooth, and depth can all be
edited in the Tool Properties dialog.

Obstructions and Holes 

You can create simple rectangular obstructions with the Draw an Obstruction  tool. Objects
created with this tool will be directly translated into FDS obstruction records. To create objects
with this tool, follow these steps:

1. Click the Draw an Obstruction  button.

2. Click the Tool Properties  button to set the obstruction properties. Define the Min Z and
Max Z coordinates and Surface Property for the obstruction.

3. Position the mouse pointer where you want to begin creating the obstruction, then press and
hold the left mouse button. The mouse coordinates are displayed in the lower-left corner of
the view to help you accurately place the object.

4. Drag the mouse to the opposite corner of your desired obstruction.

5. Release the mouse button.

You can create simple rectangular holes with the Draw a Hole  tool. The hole version of this
tool is identical to the obstruction version, except it will create FDS hole records.
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Walls and Wall Holes 

You can create walls in PyroSim using the Draw a Wall  tool. This tool is only available in

the Top View . Walls can be rotated freely in the top view and are not constrained by the FDS
grid. To create a wall using the wall tool:

1. Click the Draw a Wall  button.

2. Click the Tool Properties  button to set the wall properties.

3. Position the mouse pointer where you want to begin creating the wall, then press and hold the
left mouse button. The mouse coordinates are displayed in the lower-left corner of the view
to help you accurately place the object.

4. Drag the mouse to the end point of the wall.

5. Release the mouse button.

Walls have an associated thickness property. When you create a wall you are positioning either
the two internal or two external corners -- not the centerline. To toggle the direction that the
width of the wall extends, press the SHIFT key while creating the wall. If you release the SHIFT
key before you have completed the wall, the thickness direction will return to its default setting.

PyroSim will automatically convert walls into grid-based FDS objects when required. If you
have created a diagonal wall and want to preview the obstructions that will be created for FDS,
make sure there is a grid around the wall, and click View, then select Preview as Blocks.

You can create holes in the same manner as walls using the Draw a Wall Hole  tool. The
hole version of this tool is identical to the solid version, except it will create holes rather than
solid geometry.

Blocks and Block Holes  

You can fill individual grid blocks using the Draw a Block  tool. To create blocks using this
tool, simply click a grid cell you would like to fill. You can also click and drag the mouse across
the grid to "paint" grid blocks. The obstructions created with this tool will be the size of the grid
cells shown in the current view. The depth of the cells will not necessarily be the depth of a cell
in the current grid, however. The depth and other options for this tool can be edited in the Tool

Properties  dialog.

This tool operates on the currently selected grid. To select a grid, click View, click Select Grid,
then select the grid you would like to work with.

This tool is generally more useful when the Snap to Grid option is selected. To enable grid
snapping, click View, then select Snap to Grid. When grid snapping is disabled, this tool will
create many small, overlapping obstructions.

You can create block holes using the Draw a Block Hole  tool. The hole version of this tool
is identical to the solid version, except it will create holes rather than solid geometry.
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Rooms  

The Draw a Room  tool gives you a fast way to define the four walls of a room. This tool is

only available in the Top View . To create a room using the Draw a Room tool:

1. Click the Draw a Room  button.

2. Click the Tool Properties  button to set the properties.

3. Position the mouse pointer at one corner of the desired room, then press and hold the left
mouse button.

4. Drag the mouse to the opposite corner of the desired room.

5. Release the mouse button.

By default, the Draw a Room tool expects you to define two inner corners of the room and the
thickness of the walls will extend outward. You can press the SHIFT key while creating the room
to make the thickness of the walls extend inward. If you release the SHIFT key before you have
completed the room, the thickness direction will return to its default setting.

Vents  

You can create vents using the Draw a Vent  tool. Vents have general usage in FDS to describe
2D planar objects. Taken literally, a vent can be used to model components of the ventilation
system in a building, like a diffuser or a return. In these cases, the vent coordinates form a plane
on a solid surface forming the boundary of the duct. No holes need to be created through the
solid; it is assumed that air is pushed out of or sucked into duct work within the wall.

You can also use vents as a means of applying a particular boundary condition to a rectangular
patch on a solid surface. A fire, for example, is usually created by first generating a solid obstruc-
tion and then specifying a vent somewhere on one of the faces of the solid with the characteristics
of the thermal and combustion properties of the fuel.

There are two reserved surface types that may be applied to a vent: OPEN and MIRROR. For
more information on these types, see the chapter on Surface Properties.

There is one exception to the rule that vents must be prescribed flush against a solid obstruction
or external boundary. A vent that is prescribed in the interior of the domain, without any adjacent
solid surface, can act as a fan.

To create a vent in the 2D View, you can follow these steps:

1. Click the Draw a Vent  button.

2. Click the Tool Properties  button to set the vent properties.

3. Position the mouse pointer at one corner of the desired vent, then press and hold the left mouse
button.
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4. Drag the mouse to the opposite corner of the desired vent.

5. Release the mouse button.

The new vent will lie in the plane parallel to the viewing plane. For example, if you are using
the Top View when you draw the vent, the vent will lie in the Z plane.
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Chapter 9. Creating Complex Geometry 

This chapter provides guidance on using the geometry tools available in PyroSim to create several
geometric shapes that often appear in building models. The ability to sketch in different planes,
copy, replicate, drag, scale, and rotate objects can greatly simplify the tasks of geometry creation.

Curved Walls   

To create curved walls in PyroSim, you can use any of the following techniques:

• Draw the wall using several straight wall segments.

• Draw the wall using individual grid blocks.

• Rotate a single object to produce the desired arc.

In all of the following examples, we will use a background image as a pattern to draw against.
While this is not required, it makes creating curved surfaces much easier and one of the strengths
of PyroSim is that it allows you to sketch geometry directly on top of building design images.
The background image we will be using is shown in Figure 9.1.

Figure 9.1. Background image used for all curved wall examples

For simplicity, we will assume that horizontal distance across the entire image is 50 feet, and we
will place the origin of the model at the lower-left corner of the room shown in the image. The
brightness of the image will be set to 50%. The Configure Background Image dialog shown
in Figure 9.2 illustrates these settings.
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Figure 9.2. Background image settings for curved wall examples

Using Wall Segments

To create a curved wall section from wall segments, you can follow these steps:

1. Click the 2D View tab, and select the Draw a Wall  tool.

2. Turn off grid snapping. In the View menu, click to clear the Snap to Grid option.

3. Position the pointer at the beginning of the curve where you want to place the first wall seg-
ment.

4. Click and drag the mouse to extend the wall segment across a portion of the curve. Release
when you have completed the first segment. Shorter segments will produce smoother curves.

5. Create the next segment using the end point of the first. You can create as many segments as
you need in this way until the curve is completed.

This is the fastest way to create smooth curves in PyroSim. PyroSim will convert the curved
walls to blocks before running the FDS simulation. While smaller segments will make the wall
look better in PyroSim, placement of obstructions generated for FDS depends on the resolution
of your grid. Three different versions of a curved wall created with this technique are shown in
Figure 9.3.
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Figure 9.3. A curved wall drawn with three different segment lengths

Using extremely short line segments will probably not be of any benefit unless you also use very
small grid cells.

Using Grid Blocks

To create a curved wall section from grid blocks, you can follow these steps:

1. Create a grid. This example uses a 50.0 ft x 50.0 ft grid with 1 ft grid cells.

2. Click the 2D View tab, and select the Draw a Block  tool.

3. Turn grid snapping on. If snapping is off: in the View menu, click Snap to Grid.

4. Click each grid cell along the curved wall to place the necessary blocks.

This technique forces you to convert the curve to blocks manually, but the advantage is you know
exactly what geometry will be generated for FDS. If you have a high resolution grid, it may be
useful to drag the mouse and "paint" the curve rather than clicking individual grid blocks. The
example curved wall is shown in Figure 9.4.

Figure 9.4. A curved wall drawn using grid blocks

Rotating an Object

To create curved objects using the rotation technique, you must place an initial segment, then
perform a rotate-copy operation about the center point of your desired curve. This process is
illustrated in the following steps:



Creating Complex Geometry

47

1. Click the 2D View tab, and select the Draw a Wall  tool.

2. Turn off grid snapping. If snapping is on: in the View menu, click Snap to Grid.

3. Create an initial wall segment somewhere on the curve.

4. In the Model menu, click Rotate...

5. Select the Copy mode.

6. Specify the necessary parameters for the rotation operation. In this example, the Number of
Copies is 15, the Angle is 6.0 degrees, and the Base Point is: x=32.0 feet, y=16.5 feet.

7. Click Preview to verify that the settings are correct, then click OK.

The curve for this example is shown in Figure 9.5.

Figure 9.5. A curved wall drawn using the rotate technique

If we would have created 60 copies instead of 15 this procedure would have created a cylinder.
While complicated, the rotation approach is the most effective at creating complex symmetrical
geometry.

Trusses and Roofs    

You can create trusses by drawing a single truss out of grid blocks, then replicating that truss as
many times as needed. The following steps show how to create the trusses for an example roof.

1. Create a grid. This example uses a 10.0m x 10.0m x 10.0m grid with 0.2 meter grid cells.

2. Click the 2D View tab

3. On the toolbar, click the Front View  button.

4. On the toolbar, select the Draw a Block  tool.

5. On the toolbar, click the Tool Properties  button, and set Max Y to 0.2 meters.
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6. Turn grid snapping on. If snapping is off: in the View menu, click Snap to Grid.

7. Create the first truss by clicking the desired blocks.

8. Select the entire truss, open the Model menu, and click Copy/Move...

9. In the Translate dialog: select Copy, set Number of Copies to 4, set Offset to be 2.0 meters
along the Y axis, and click OK.

The trusses created in this example are shown in Figure 9.6.

Figure 9.6. Trusses created using the grid block tool and the replicate function

You can quickly add a roof to the model using the New Triangle  tool. The following steps
show how to add a roof to the previous truss example using triangles.

1. On the main toolbar, click the New Triangle  button.

2. In the Triangle Properties dialog, specify the following values for the three points. Point1:
(0.0, 8.2, 7.4), Point2: (5.0, 8.2, 10.0), and Point3: (0.0, 0.0, 7.4).

3. Click the OK button. You should see a triangular roof section laying across some of the trusses
we created in the previous example.

4. Add the other three roof sections, their coordinates are:

Point 1 Point 2 Point 3

(0.0, 0.0, 7.4) (5.0, 8.2, 10.0) (5.0, 0.0, 10.0)
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Point 1 Point 2 Point 3

(10.0, 0.0, 7.4) (5.0, 0.0, 10.0) (10.0, 8.2, 7.4)

(10.0, 8.2, 7.4) (5.0, 0.0, 10.0) (5.0, 8.2, 10.0)

Notice that the coordinates for each roof section were given in counter-clockwise order (if you are
looking down from above the model). The ordering of the coordinates determines the direction
in which the width of the triangle extends. For triangle width, PyroSim uses a left hand rule.
This means the width of each roof section will extend upward. The result of adding all four roof
triangles is shown in Figure 9.7.

Figure 9.7. A roof created with the triangle tool

Stairs  

You can create simple stairways by placing the initial stair, then using the translate-copy opera-
tion. This section will present a simple example to illustrate the approach.

We will create a 10 step stairway. Each step will have a 7 inch rise (0.58 feet), and a 10 inch
(0.83 feet) run. The stairway itself will be 24 inches (2.0 feet) wide. To keep things as simple as
possible, we will construct the stairway in an empty model.

1. On the Model menu, click New Obstruction...

2. In the Obstruction Properties dialog, specify the min point as (0.0, 0.0, 0.0) and
the max point as (2.0, 0.83, 0.58).

3. On the Model menu, click Copy/Move....
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4. In the Translate dialog, select Copy, set the Number of Copies to 9, set the Offset to (0.0,
0.83, 0.58), and click OK.

The stairway generated in this example is shown in Figure 9.8.

Figure 9.8. A stairway created with the replicate tool
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Chapter 10. Working with Geometry Objects

Selection 

PyroSim relies heavily on the idea of selected objects. For almost all operations, the user first

selects an object(s) and then changes the selected object(s). The Selection Tool  is used to
select objects.

• A left mouse click on an object in any view will select it.

• Holding Ctrl while clicking will toggle the item in the selection, adding previously unselected
items and removing previously selected items.

• Holding Alt while clicking an object in the 3D View or the 2D View will select the entire
group that the object belongs to.

• In the Navigation View, a range of objects can be selected by clicking the first object, then
holding Shift while clicking the last object.

• In the 2D View, multiple objects can be selected with a click-drag motion to define a selection
box.

Once objects have been selected, the user can modify the object using the menus.

Selection can be made in any of the views using the Selection tool. Multiple objects can be
selected using the Ctrl key or click and drag to define a box. In the Navigation View, the Shift
key can be used to select a consecutive list of objects.

Context Menus 

A right-click on a selection displays a context menu. This menu includes the most common op-
tions for working with the object. The user may also right-click on individual objects for imme-
diate display of the context menu.

Undo/Redo 

All geometric changes to the model can be undone and redone using the Undo  and Redo 
buttons, as well as Ctrl+Z and Ctrl+Y, respectively.

Copy/Paste 

Select an object to copy, then either use Ctrl+C or Edit->Copy to copy. Alternately, right-click
on an object to display the context menu with Copy.

Either use Ctrl+V or Edit->Paste to paste a copy of the object. Alternately, right-click on an
object to display the context menu with Paste.

Copy/Paste from Other Models

By running two instances of PyroSim, you can copy objects from one model and paste them
into a second model. If the copied objects rely on other properties, such as surfaces, that are not
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included in the second model, these properties will be pasted into the model when the objects
are pasted.

Copy/Paste from Text Files

Copy/paste can also be performed to and from text files. For example the user can select an object
in PyroSim, open a text file, and paste the object. The text FDS representations of the object
and dependent properties will be pasted. Alternatively, the user can copy the text from an FDS
file and paste into PyroSim (the 3D View, 2D View, or Navigation View). The object will be
added to the PyroSim model. An error message will be received if the pasted object depends on
data that is not available in the PyroSim model. The user will then need to paste that information
(such as surface properties) first before pasting the geometric object.

Double-Click to Edit 

Double-clicking on an object opens the appropriate dialog for editing the object properties.

Resize an Object  

When an object is selected in either the 2D or 3D Views, handles are displayed on the corners of
the object. The user can click on any of the handle "dots" to resize the object. Selecting a dot at
the end of a handle restricts motion to the corresponding axis; selecting the dot at the intersection
of the handles allows motion in both directions.

The handles behave the same in 2D and 3D.

Translating (Dragging) Objects in 2D View  

Handles are used to translate (drag) objects in the 2D View. To translate an object, follow these
steps:

• Using the Selection tool , select the object(s) to be dragged.

• Select the Translate Objects tool .

• By default, handles will be positioned at the center of the selection. A click anywhere on the
grid will pin these handles to a new location, such as a corner of the object Figure 10.1.

• Click and drag the intersection of the handles to translate in any direction; click and drag one
of the handles to constrain translation to the X or Y direction.
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Figure 10.1. Edit handles of a selected object

Rotating Objects in 2D View 

Handles are used to rotate objects in the 2D and 3D Views. To rotate an object, follow these steps:

• Using the Selection tool , select the object(s) to be rotated.

• Select the Rotate Objects tool .

• By default, handles will be positioned at the center of the selection. A click anywhere on the
grid will pin these handles to a new location, such as a corner of the object Figure 10.2. The
location of the handles defines the center of rotation.

• Click and drag the far "dot" of the handles to rotate. Aligned objects only rotate in 90 degree
increments. Non-aligned objects, such as diagonal walls, can be rotated any angle.

Figure 10.2. Rotate handles for selected objects

Translate and Copy Dialog    

The Translate dialog can be used to both move an object and to create copies of an object, each
offset in space, Figure 10.3. The Mode selects either the option to move only the selected object
or to create copies of the object. The Offset parameters indicate the increment to move or offset
the copies.

To preview the changes without applying them, click Preview. To apply the changes and close
the dialog, click OK. To cancel the changes instead, click Cancel.
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Figure 10.3. The translate dialog being used to make offset copies of an object

Mirror and Copy Dialog   

The Mirror dialog can be used to mirror an object about a plane or planes, Figure 10.4. The Mode
selects either the option to mirror only the selected object or to create a mirrored copy of the
object. The Mirror Plane(s) define planes normal to the X, Y, and Z axes about which the object
will be mirrored. The Use Center button can be used to fill the Mirror Plane data with the center
coordinates of the selected objects.

To preview the changes without applying them, click Preview. To apply the changes and close
the dialog, click OK. To cancel the changes instead, click Cancel.

Figure 10.4. The mirror dialog being used to make a mirrored copy of an object

Scale and Copy Dialog   

The Scale dialog can be used to change the size of an object Figure 10.5. The Mode selects either
the option to scale only the selected object or to create multiple scaled copies of the object. The
Scale values define the scale factors in the X, Y, and Z directions. The Base Point defines the
point about which the scaling will be performed. The Use Center button can be used to fill the
Base Point data with the center coordinates of the selected objects.
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To preview the changes without applying them, click Preview. To apply the changes and close
the dialog, click OK. To cancel the changes instead, click Cancel.

Figure 10.5. The scale dialog being used to scale an object

Rotate and Copy Dialog   

The Rotate dialog can be used to rotate an object Figure 10.6. The Mode selects either the option
to rotate only the selected object or to create multiple rotated copies of the object. The Rotation
values allow the user to select the Axis about which the rotation will be made and the angle is the
rotation angle (counter-clockwise is positive). The Base Point defines the point about which the
rotation will be performed. The Use Center button can be used to fill the Base Point data with
the center coordinates of the selected objects.

To preview the changes without applying them, click Preview. To apply the changes and close
the dialog, click OK. To cancel the changes instead, click Cancel.

Figure 10.6. The rotate dialog being used to rotate an object
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Display Only Selected Objects   

Often it is desirable to turn off the display of selected objects, for example, to hide a roof of a
building in order to visualize the interior. In any of the views, right-click on a selection to obtain
the following options:

• Hide object(s) - This turns off the display of the selected object(s).

• Show object(s) - This turns on the display of the selected object(s).

• Filter object(s) - This turns off the display of all objects except the selection(s).

• Show all objects - Turns on the display of all objects.
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Chapter 11. Reactions 

This chapter provides an overview of how to specify combustion (the reaction of fuel vapor and
oxygen) using PyroSim. A more detailed discussion of this topic is provided in the Fire Dynamics
Simulator User's Guide ([McGrattan et al., 2007]) and the Fire Dynamics Simulator Technical
Reference Guide ([McGrattan et al., 2007]).

As described in the Fire Dynamics Simulator User's Guide ([McGrattan et al., 2007]), a common
source of confusion in FDS is the distinction between gas phase combustion and solid phase
pyrolysis. The former refers to the reaction of fuel vapor and oxygen; the latter the generation
of fuel vapor at a solid or liquid surface. In an FDS fire simulation, there is only be one gaseous
fuel that acts as a surrogate for all the potential fuel sources. The reaction is defined using the
Edit Reactions dialog in PyroSim.

The PyroSim interface supports only the mixture fraction model to account for the evolution of
the fuel gas from its surface of origin through the combustion process. The alternative provided
in FDS5 is the finite-rate approach, where all of the individual gas species involved in the com-
bustion process are defined and tracked individually. This finite-rate approach is recommended
only for Direct Numerical Simulation. The mixture fraction model is the most frequently used
approach..

Mixture Fraction Combustion

In FDS, there are two ways of designating a fire: the first is to specify a Heat Release Rate Per
Unit Area (HRRPUA) as part of a surface, the other is to specify a HEAT_OF_REACTION,
along with other thermal parameters, as part of a material. In both cases, the mixture fraction
combustion model is used.

The heat release rate approach is the simplest way to specify a fire. All that needs to be done is
create a burner surface with the desired heat release rate (see Chapter 6, Surfaces ). If no other
reaction is specified, propane will be used as the surrogate fuel. If a reaction is specified, that
reaction will be used to calculate the combustion products.

In the mixture fraction model, the reaction is assumed to be of the form:

Figure 11.1. Reaction equation

The user specifies the chemical formula of the fuel along with the yields of CO, soot, and H2,
and the amount of hydrogen in the soot. For completeness you can specify the N2 content of the
fuel and the presence of other species.

To edit a reaction:

1. On the Model menu, click Edit Reactions....

2. On the Fuel tab, enter the number of atoms in the reaction equation. The input for an ethanol
reaction as defined in the ethanol_pan.fdsexample distributed with FDS5, is shown in Fig-
ure 11.2. The fuel is defined by 2 carbon atoms, 6 hydrogen atoms, and 1 oxygen atom.
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3. If desired, change the default values for the Ambient Oxygen Mass Fraction
(Y_O2_INFTY), the Mass Fraction of Fuel in Burner (Y_F_INLET), and the Upper limit
of flame heat release rate (HRRPUA_SHEET).

4. On the Fire Suppression tab, you can enable fire suppression and then enter val-
ues for the Limiting Oxygen Index (X_O2_LL) and the Critical Flame Temperature
(CRITICAL_FLAME_TEMPERATURE). The default values are shown in Figure 11.3.

5. On the Byproducts tab, you can select either Specify release per unit mass oxygen
(EPUMO2) or specify heat of combustion (HEAT_OF_COMBUSTION). You can also
specify the CO yield, H2 yield, and Soot yield. The values used for the ethanol pan fire are
shown in Figure 11.4

6. On the Soot tab, you can define the fraction of the atoms in the soot that are hydrogen, Hydro-
gen Fraction (SOOT_H_FRACTION) and the parameters that control visibility. See Chapter
12 of the Fire Dynamics Simulator User's Guide ([McGrattan et al., 2007]). The default values
are shown in Figure 11.5

Figure 11.2

Figure 11.2. Fuel panel of the Edit Reactions dialog for an ethanol fire
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Figure 11.3. Fire Suppression panel of the Edit Reactions dialog. These are the FDS5 default values.

Figure 11.4. Byproducts panel of the Edit Reactions dialog for an ethanol fire

Figure 11.5. Soot panel of the Edit Reactions dialog for an ethanol fire. These are the FDS5 default
values.
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Chapter 12. Particles 

PyroSim supports four types of particles: massless tracers, water droplets, fuel droplets, and a
generic particle that provides the same options as water droplets.

Massless Tracers

Massless tracer particles can be used to track air flow within a simulation. They can be used with
the particle injection feature of the Burner, Heater/Cooler, Blower, and Layered surface types.
They can also be used in particle clouds.

By default, PyroSim provides a black, massless tracer particle called Tracer. To use a custom
tracer particle in your simulation, you can modify the parameters of this default particle to suit
your needs, or you can create a new particle. To create a new massless tracer particle:

1. On the Model menu, click Edit Particles...

2. Click New...

3. In the Particle Type box, select Massless Tracer

4. Click OK

You can now edit the particle properties.

Parameter Description

Duration The amount of time a droplet of this type will remain in the
simulation.

Insertion Interval The amount of time between droplet insertions.

Sampling Factor Sampling factor for the particle output file. A value of -1 us-
es the FDS default value for this property. Set to an integer
greater than 1 to reduce the size of particle output.

Water Droplets

Water droplets can be used with sprinkler spray models and nozzles to customize the spray. They
can also be used in particle clouds and surface types that support particle injection.

By default, PyroSim provides a water particle called Water that has all of the common properties
of water. To use a custom water droplet in your simulation, you can modify the default water
definition to suit your needs or you can create a new droplet type by clicking New....

Water droplets support the following Thermal Properties:

Parameter Description

Initial Temperature The initial droplet temperature.

Density The droplet density.

Specific Heat The droplet specific heat.
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Pyrolysis:

Parameter Description

Melting Temperature The droplet melting/freezing temperature.

Vaporization Temperature The droplet liquid boiling temperature.

Heat of Vaporization The droplet latent heat of vaporization.

Coloring:

Parameter Description

Default Select to FDS to select a color for this particle.

Specify Select to choose a custom particle color.

By Droplet Property Select this option to choose one or more scalar quantities that
will be used to color this particle in Smokeview.

Size Distribution:

Parameter Description

Median Diameter The median volumetric diameter of each droplet.

Constant Use a constant diameter for each droplet.

Rosin-Rammler Rather than use a constant diameter for each droplet, allow
each to be sized according to a combination of Rosin-Ramm-
ler and log-normal.

Distribution (gamma) The width of the distribution. The larger the value of gamma,
the narrower the droplet size is distributed about the median
value.

Minimum Diameter Droplets smaller than the minimum diameter are assumed to
evaporate in a single time step.

Maximum Diameter Droplets larger than the maximum diameter are assumed to
break up in a single time step.

Injection:

Parameter Description

Droplets per Second The number of sprinkler droplets inserted every second
per active sprinkler. This parameter only affects sprinkler
droplets.

Duration The amount of time a water droplet will remain in the simula-
tion.

Insertion Interval The amount of time between droplet insertions.

Sampling Factor Sampling factor for the particle output file. A value of -1 us-
es the FDS default value for this property. Set to an integer
greater than 1 to reduce the size of particle output.
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Fuel Droplets

Fuel droplets can be used with sprinkler spray models and nozzles to customize the spray. They
can also be used in particle clouds and surface types that support particle injection. Fuel droplets
are initially burning and do not require an ignition source.

By default, PyroSim provides a fuel droplet type called Fuel. To use a custom fuel droplet, you
can modify the default fuel definition to suit your needs, or you can create a new droplet type
by clicking New....

The parameters for fuel droplets are identical to the options for water droplets with one exception.
Fuel droplets have a Heat of Combustion pyrolysis option. This option lets you specify the heat
of combustion of the liquid fuel.

Global Parameters

There are two global options relating to particles in the Simulation Parameters dialog. The first
option, Droplets Disappear at Floor, can be used to prevent droplets from gathering on the
floor of the simulation area. The default value for this option is ON. The second option, Max
Particles per Mesh, can be used to set an upper limit on the number of particles allowed in any
simulation mesh.
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Chapter 13. Devices 

Devices are used to record entities in the model or to represent more complex sensors, such
as smoke detectors, sprinklers, and thermocouples. You can make time history plots of device
output in PyroSim by opening the CHID_devc.csv file.

Devices can be moved, copied, rotated, and scaled using the tools described in Chapter 10, Work-
ing with Geometry Objects. Most often, the user will simply select one or more devices, right-
click to display the context menu, and click Copy/Move. By copying a single device along a
line and then copying the line in the normal direction, it is possible to quickly define an array
of devices.

After a device is defined, it can be used to activate an object. The value that triggers the activation
(setpoint) is defined when the activation event is selected. For example, on the Activation Events
tab of an obstruction.

Aspiration Detection Systems

An aspiration detection system groups together a series of soot measurement devices. An aspi-
ration system consists of a sampling pipe network that draws air from a series of locations to a
central point where an obscuration measurement is made. To define such a system in FDS, you
must provide the sampling locations, sampling flow rates, the transport time from each sampling
location, and if an alarm output is desired, the overall obscuration setpoint.

To define the soot meassurement devices:

1. On the Devices menu, click New Aspirator Sampler...

2. Enter the Name and Location of the sampler.

3. Click OK to create the sampler.

To define the aspiration detection system:

1. On the Devices menu, click New Aspirator... .

2. Give the Name and select which Aspirator Samplers will be included. For each sampler,
provide the data described below.

3. Click OK to create the aspirator detector.

Supply the following information for the aspiration detection system, Figure 13.1.

Parameter Description

Aspirator Name The name of the aspiration detection system.

Bypass Flow Rate The flow rate of any air drawn into the system from outside
the computational domain.

Transfer Delay The transport time from the sampling location to the central
detector.
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Parameter Description

Flowrate The gas flow rate.

Location The coordinates of the aspiration detection system.

Orientation Not used.

Rotation Not used.

Figure 13.1. Creating an aspirator sampler

The output of the aspiration detection system will be the combined obscuration. At this time,
PyroSim does not support a setpoint for an aspiration detection alarm.

Gas and Solid Phase Devices

Simple gas phase and solid phase devices can be used to measure parameters in the gas or solid
phase. To define a meassurement device:

1. On the Devices menu, click New Gas-phase Device... or New Solid-phase Device... .

2. Enter the Name of the device.

3. Select the Quantity to be measured.

4. Enter the Location of the device.

5. Click OK to create the device.

Thermocouple

To create a thermocouple:

1. On the Devices menu, click New Thermocouple... .

The thermocouple properties are:

Parameter Description

Device Name The name of the thermocouple.

Bead Diameter The bead diameter of the thermocouple.
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Parameter Description

Emissivity The emissivity of the thermocouple.

Location The coordinates of the device.

Orientation Not used.

Rotation Not used.

The output of the thermocouple is the temperature of the thermocouple itself, which is usually
close to the gas temperature, but not always, since radiation is included in the calculation of
thermocouple temperature.

Flow Measurement

The flow measurement device can be used to measure a flow quantity through an area. To create
a flow measuring device:

1. On the Devices menu, click New Flow Measuring Device... .

The flow measurement device properties are:

Parameter Description

Device Name The name of the flow measuring device.

Quantity The quantity to be measured.

Flow Direction Select the direction for the measurement as defined by the
normal to the measurement plane.

Plane The axis normal to the measurement plane and the location of
that plane on the axis.

Bounds The coordinates of the area normal to the axis.

The output will be the total flow through the defined area.

Heat Release Rate Device

The heat release rate device measures the heat release rate within a volume. To define a heat
release rate device:

1. On the Devices menu, click New Heat Release Rate Device... .

The heat release rate device properties are:

Parameter Description

Device Name The name of the heat release rate device.

Bounds The coordinates of the volume within which to calculate the
heat release rate.
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The output will be the total heat release rate within the volume.

Layer Zoning Device

There is often the need to estimate the location of the interface between the hot, smoke-laden
upper layer and the cooler lower layer in a burning compartment. Relatively simple fire models,
often referred to as two-zone models, compute this quantity directly, along with the average
temperature of the upper and lower layers. In a computational fluid dynamics (CFD) model like
FDS, there are not two distinct zones, but rather a continuous profile of temperature. FDS uses
an algorithm based on integration along a line to estimate the layer height and the average upper
and lower layer temperatures. To define a layer zoning device:

1. On the Devices menu, click New Layer Zoning Device... .

The layer zoning device properties are:

Parameter Description

Device Name The name of the layer zoning device.

Checkboxes Checkboxes to select the output from the device (layer height,
upper temperature, lower temperature).

Path The coordinates of the end points of a line along which the
layer height will be calculated. The two endpoints must lie in
the same mesh.

The output will be the quantities selected.

Path Obscuration (Beam Detector) Device

A beam detector measures the total obscuration between points. To define a beam detector de-
vice:

1. On the Devices menu, click New Path Obscuration Device... .

The path obscuration device properties are:

Parameter Description

Device Name The name of the path obscuration device.

Path The coordinates of the end points of a line along which the
obscuration will be calculated. The two endpoints must lie in
the same mesh.

The output will be the percent obscuration along the path.

Heat Detector Device
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A heat detector measures the temperature at a location using a Response Time Index model. To
define a heat detector device:

1. On the Devices menu, click New Heat Detector... .

The heat detector device properties are:

Parameter Description

Device Name The name of the heat detector.

Link The link defines the activation temperature and the response
time index.

Location The coordinates of the device.

Orientation Not used.

Rotation Not used.

The output will be the heat detector temperature.

Smoke Detector Device

A smoke detector obscuration at a point with two characteristic fillin or "lag" times. To define
a smoke detector:

1. On the Devices menu, click New Smoke Detector... .

The smoke detector device properties are:

Parameter Description

Detector Name The name of the smoke detector.

Model Select the smoke detector type. You can edit the smoke detec-
tor parameters to create a new type.

Location The coordinates of the device.

Orientation Not used.

Rotation Not used.

The output will be the percent obscuration per meter.

Sprinklers 

Sprinklers can spray water or fuel into the model. To define a sprinkler:

1. On the Devices menu, click New Sprinkler... . This will display the Sprinkler dialog, Fig-
ure 13.2.

2. Select the desired options and define required input parameters as described below.

3. Click OK to create the sprinkler.
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Figure 13.2. Creating a new sprinkler

The sprinkler properties are:

Parameter Description

Sprinkler Name The name of the sprinkler.

Spray Model The spray model defines the particle type (water and fuel are
default options), the flow rate, and the jet stream shape.

Dry Pipe In a dry pipe sprinkler system, the normally dry sprinkler
pipes are pressurized with gas. When a link activates in a
sprinkler head, the pressure drop allows water to flow into the
pipe network. You can create a dry pipe and edit the delay.

Activator By default the sprinkler is activated by a temperature link,
with a response time index. You can edit the activation tem-
perature and the response time index. Alternately, you can se-
lect a more general quantity to activate the sprinkler. By de-
fault the sprinkler is initially not active and is triggered only
once.

Location The coordinates of the sprinkler.

Orientation The components of the direction vector.

Rotation Normally not used for a sprinkler. It could be used to rotate a
spray pattern that varies with latitude (circumferentially).

Nozzle 

Nozzles are very much like sprinklers, only they do not activate based on the standard RTI model.
The can be set to activate by devices.
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Chapter 14. Output Controls 

In this chapter we describe the simulation output options available in PyroSim. Each of these
options is located in the Output menu.

Solid Profiles

Solid profiles measure quantities (e.g. temperature, density) as they extend into solid objects.
The output file for this measurement device will be named CHID_prof_n where CHID is the
job ID and n is the index of the solid profile. This output file contains the data necessary to create
an animated 2D chart of the quantity as it extends into the object over time. PyroSim does not
currently support displaying this output file.

To generate solid profile output, on the Output menu, click Solid Profiles.... Each solid profile
requires the following parameters:

Parameter Description

ID The name of this solid profile entry.

X, Y, Z The coordinates of a point on the face that will be examined
by this solid profile.

ORIENT The direction of the face that will be examined by this solid
profile. To generate solid profile output for the top of an ob-
ject, this value will be Z+. This parameter prevents any ambi-
guity that might result from a point that lies on two adjoining
faces.

QUANTITY The quantity that will be measured in this solid profile.

Note

The surface to be measured must be heat-conducting. If the surface on the specified face
is not heat-conducting, FDS will issue an error and exit before running the simulation.

Slices  

Slices or slice planes measure gas-phase data (e.g. pressure, velocity, temperature) on an ax-
is-aligned plane. This data can then be animated and displayed using Smokeview (Figure 14.1).
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Figure 14.1. An example of a slice plane shown in Smokeview.

To generate animated slice planes, on the Output menu, click Slices.... Each slice plane requires
the following parameters:

Parameter Description

XYZ Plane The axis (X, Y, or Z) along which to place the slice plane.

Plane Value The value along the specified axis where the plane will be
placed.

Gas Phase Quantity The quantity that this plane will measure. This list includes
built-in options such as temperature as well as dynamic op-
tions such as those based on particles.

Use Vector? Setting this option to YES will cause FDS to generate addi-
tional flow vector data for this slice plane.

Slice files may be viewed in Smokeview by selecting Load/Unload->Slice file. To view the
vector representation, select Load/Unload->Vector slices.

Boundary Quantities  

Boundary quantities provide a way to visualize output quantities (e.g. temperature) on the walls
of every obstruction in the simulation. This data can be animated and visualized in Smokeview
(Figure 14.2). Since the data applies to all surfaces in the simulation, no geometric data needs
to be specified.
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Figure 14.2. An example of a boundary quantity shown in Smokeview.

To generate boundary quantity data, on the Output menu, click Boundary Quantities.... In
the Animated Boundary Quantities dialog, you can select each quantity you would like to be
available for visualization.

To view boundary data in Smokeview (e.g. wall temperature), right-click to open the menu, then
select: Load/Unload->Boundary File->WALL_TEMPERATURE.

Isosurfaces  

Isosurfaces are used to plot the three dimensional contour of gas phase quantities. This data can
be animated and visualized in Smokeview (Figure 14.3).
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Figure 14.3. An example of an isosurface shown in Smokeview.

To generate isosurface data, on the Output menu, click Isosurfaces.... In the Animated Isosur-
faces dialog, you can select each quantity you would like to be available for visualization. Then
you must enter values at which to display that quantity in the Contour Values column. If you
enter more than one contour value, each value must be separated by the semi-colon character
(;). Once you have finished typing the value, press enter.

To view isosurface data in Smokeview, right-click to open the menu, then select: Load/Un-
load->Isosurface File->TEMPERATURE.

Plot3D Data  

Plot3D is standard file format and can be used to display 2D contours, vector plots, and isosur-
faces in Smokeview (Figure 14.4).
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Figure 14.4. An velocity Plot3D data shown in Smokeview.

By default, Plot3D data will be generated for the following quantities: Heat Release Rate per
Unit Volume (HRRPUV), Temperature, U-Velocity, V-Velocity, and W-Velocity. To change
the Plot3D output quantities, on the Output menu, click Plot3D Data.... In the Plot 3D Static
Data Dumps dialog, select the output quantities to generate. Since FDS supports a maximum of
five Plot3D output quantities, you must remove some existing quantities to add new ones.

Statistics  

Statistics output is an extension of the devices system. You can insert a statistics gathering device
and it will output data about the minimum, maximum, and average value of a particular quantity
in one or more grids. This data can then be viewed in a 2D chart using PyroSim (Figure 14.5).

Figure 14.5. An example of an isosurface shown in Smokeview.
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To generate statistics data for one or more grids, on the Output menu, click Statistics..., then
click New.... The following options are available:

Parameter Description

Quantity The quantity that will be measured. This value is set when
you create the statistics entry and cannot be modified.

Mean Select this option to output the average value of the measured
quantity over time in a grid.

Minimum Select this option to output the minimum value of the mea-
sured quantity over time in a grid.

Maximum Select this option to output the maximum value of the mea-
sured quantity over time in a grid.

Recording Grids Select each grid for which you would like to output this statis-
tical data.

The output file for measurement devices will be named CHID_devc.csv where CHID is the
job ID.

Note

When using statistics data, it is important to consider nuances of FDS's numerical solver.
For instance, the minimum statistic is sensitive to numerical errors in the solver during
species transport and will sometimes report artificially low values.
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Chapter 15.  Running the Simulation

Once you have created a fire model, you can run the simulation from within PyroSim. On the
FDS menu, click Run FDS.... This will launch the FDS Simulation dialog shown in Figure 15.1.
This dialog can be minimized and you can continue using PyroSim (and even run additional
simulations) while a simulation is running.

Figure 15.1. The FDS simulation dialog

You can save the simulation log at any time by clicking Save Log. This log will be saved as
a text file.

You can also run Smokeview while the simulation is in progress by clicking Run Smokeview.
For details on how to use Smokeview, please consult the Smokeview users guide. Smokeview
will run automatically when the simulation is finished.

Clicking Stop will cause PyroSim to create a .stop file that signals FDS to stop the simulation,
but also write out a checkpoint file that can be used to resume the simulation later. There is often
a significant delay between the time when you click the Stop button and when the simulation
actually terminates. This is because FDS checks for the stop file at the same rate that it updates
the progress information.

To immediately terminate the current simulation, you can click Kill or close the dialog. You will
not be able to resume the current simulation.

Resuming a Simulation

To resume a partially completed simulation, on the FDS menu, click Resume Simulation.... This
will cause an additional RESTART flag to be written to the FDS input file. When FDS detects
this flag it will automatically attempt to reload the previous execution state from the hard disk



Running the Simulation

76

and resume where it left off. If FDS is unable to load the previous execution state, it will exit
with an error.

Parallel Execution

PyroSim includes support to launch a parallel simulation using MPI. When running a simulation
in parallel, all of the computation within each of the grids can take place independently. Assum-
ing a simulation executes in t seconds using only one processor, the best possible performance
improvement using n processors and n grids is a reduction to t/n seconds1. In reality, this is not
generally possible due to communications overhead and load balancing.

PyroSim's support for parallel execution is restricted to a single machine and is only beneficial
on machines that have dual core or multiple CPUs.

To launch a parallel simulation in PyroSim, on the FDS menu, click Run Parallel FDS....

To resume a parallel simulation, on the FDS menu, click Resume Parallel FDS.... The process
to resume a parallel simulation is identical to resuming single processor simulation (described
above).

Before running a parallel simulation, you may want to take into account some guidelines:

• Use at least as many grids as available processors (or cores). If there are 4 available processors
and only two grids, the additional two processors will not be used.

• Do not overlap grids. Since information is exchanged between grids at the edges, it is ideal
to organize grids in such a way that they touch, but do not overlap. It is not recommended
to embed a fine grid within a coarse grid in an attempt to improve localized grid resolution.
Because information is exchanged at grid boundaries, the outer grid will not receive any data
from the inner grid.

• Do not allow a fire source to cross grid boundaries. When a fire source crosses grid boundaries,
it is not possible to maintain the same level of simulation accuracy.

For a detailed list of suggestions and information about running FDS in parallel, please consult
section 6.3.2 of the FDS Users Guide.

1This is also referred to as a linear performance improvement, or linear speedup.



77

Chapter 16. Post-Processing 

PyroSim supports post-processing in two ways:

• Launching of Smokeview from within PyroSim, and

• Time history plots of output data.

Launching Smokeview 

By default, if you run FDS from within PyroSim, Smokeview will be launched at the end of the
FDS run. Alternately, you can select FDS->Run Smokeview... and a new window will open.
From here the standard Smokeview controls, accessed by a right-click on the image, are used
to display results.

Time History Results 

Time history results are saved for heat detectors, thermocouples, and other fire output. A quick
display of these results can be obtained by selecting FDS->Plot Time History Results.... Open
the desired data file for display. A typical heat detector plot is shown in Figure 16.1. The user
can export the image to a file.

Figure 16.1. Defining the grid boundaries
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Chapter 17. Troubleshooting 

Licensing/Registration Problems   

On a few machines, a licensing error occurs when first running PyroSim. If you receive a
message such as "NETWORK: Network drivers appears to not be serving this directory" or
"INIT_NOT_SUCCEEDED", please perform the following steps:

1. Go to the installation directory C:\Program Files\PyroSim\

2. In this directory, double click (execute) the file SETUPEX.exe

3. You should now be able to run PyroSim and complete the registration process.

Video Display Problems     

PyroSim utilizes many advanced graphics card features in order to provide accelerated display of
models in three dimensions. If you have problems with display, such as corruption of the image
when you move the mouse, go to File->Preferences and turn off the fast hardware drawing
options. This will disable the image caching and force PyroSim to always re-render the model.
This should correct any display problems at the expense of speed.

You can also turn off graphics acceleration by starting PyroSim in Safe Mode. Select Run, All
Programs, PyroSim, and then PyroSim (Safe Mode).

If you encounter this problem, please let us know the make/model of your video card and what
video driver you are using. That will help us improve the faster version to work on more com-
puters.

Memory for Large Models     

When running large models, it is possible that an out of memory error will be encountered. If
this occurs, you can increase the default Java heap size. In our experience, the maximum size
can be specified to approximately 70% of physical memory.

To specify the memory, you can either run from a command line or change the shortcut properties.
To run from a command line, open a command window and then go to the PyroSim installation
directory (usually C:\Program Files\PryoSim). Execute PyroSim on the command line using a -
mem flag. For example, pyrosim -mem1200 will request 1.2 GB of memory.

To edit the PyroSim shortcut properties, right-click on the PyroSim icon, select the Shortcut tab,
and then edit the Target by adding a space and -mem1200 to the end of the Target. A typical
Target will then read "C:\Program Files\PyroSim\pyrosim.exe" -mem500.

Contacting Technical Support

The PyroSim software is available for download at: http://www.thunderheadeng.com The same
site provides PyroSim user manuals and example problems. Please follow the examples to be-
come familiar with the software.

http://www.thunderheadeng.com
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Questions and suggestions should be sent to support@thunderheadeng.com or by phone to
+1.785.770.8511.

Mail should be sent to:

    Thunderhead Engineering
    403 Poyntz Ave.
    Suite B
    Manhattan, KS 66502-6081
    USA
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Appendix A. Opening FDS v4 and PyroSim v2006 Files 

Due to the differences between versions 4 and 5 of FDS, it is not always possible to automatically
convert legacy FDS input files and PyroSim 2006 PSM files to the new version. However, many
conversions are possible and in many cases PyroSim can completely convert old input files to
the new format.

PyroSim will begin the conversion process as a result of either of two actions: (1) opening a PSM
file saved with a version of PyroSim designed to work with version 4 of FDS, and (2) importing
an FDS input file designed to work with version 4 of FDS.

In many cases, PyroSim 2007 can import records intended for version 4 of FDS that PyroSim
2006 could not. This is because PyroSim 2007 supports a broader range of FDS features than
the previous version. Examples of previously unsupported version 4 features that can now be
imported include solid-phase thermocouples and extra species.

The process for converting PSM files and FDS input files is identical. PyroSim first loads the
data into a form designed to work with version 4 of FDS, then applies conversion logic to pro-
duce the corresponding data structures designed to work with version 5 of FDS. When PyroSim
encounters a record that cannot be automatically converted, a warning message is generated.
Each warning contains information about the source of the problematic record and the action
taken. Some records are simply dropped and others are converted to default values. If a record
is encountered that cannot be converted, but contained only default values and would not have
affected the simulation, that record is dropped without issuing a warning.

Great care was taken to ensure that PyroSim generates these warnings whenever they contain
important information, but not so often that they distract from important issues. When in question,
PyroSim will err on the side of caution and generate a warning message. An example of this
warning dialog is shown in Figure A.1. If no warning dialog appears, PyroSim was able to convert
the input file without encountering any compatibility issues.

Figure A.1. An example of the warning dialog shown after loading the FDS4 townhouse model.
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In most cases, the following records can be converted with no additional input:

• Geometry Data (walls, holes, triangles, etc...)

• Textures

• Grids

• Floors

• Particles1

• Smoke Detectors

• Thermocouples

• Heat Detectors

• Boundary Quantity Output

• Plot3D Data

• Isosurfaces

• Slices

• Unsupported Records2

Global Simulation Parameters

The following items that can be set in the Simulation Parameters dialog of PyroSim 2006 are
not supported in PyroSim 2007 and will be dropped.

• Under the Simulator tab, Incompressible Calculation (excludes heat)

• Under the Environment tab, External Temperature

• Under the Particles tab, Droplet Insert Interval

• Under the Particles tab, Max Particles per Second

All other simulation parameters will be converted to PyroSim 2007 without warnings.

Note

In PyroSim 2007 it is possible to specify both the particle insertion interval and the
particle insertion rate on a per particle basis. These options are available in the Edit
Particles dialog, in the Injection tab. PyroSim does not automatically apply the global
data to these fields.

Sprinklers and Pipes

All correctly specified sprinkler parameters are converted without warnings. If a sprinkler has
been assigned a massless particle, however, that sprinkler will be assigned a particle with param-
eters from the make file, and a warning will be issued.
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For FDS 4 sprinkler make files, PyroSim has a robust built-in parser that can handle both simple
and complex spray patterns. The only requirement is that referenced make files must exist in the
fds folder in the PyroSim install directory. PyroSim 2007 ships with the make files provided
by NIST for FDS 4. If a file uses another make file, place it in this directory before importing
or opening the file.

If there is a dry pipe delay greater than zero, PyroSim 2007 will create a single dry pipe with that
delay and attach it to all the sprinklers in the model. Note, however, that in PyroSim 2007 the
water pressure is specified per sprinkler rather than per pipe. Because of this, PyroSim will not
convert the dry pipe pressure specified in the pipe record, and a warning will be issued.

Reactions

To convert reaction data into a form useable by version 5 of FDS, PyroSim 2007 must reverse-en-
gineer the fuel molecule composition based on stoichiometric coefficients. To accomplish this,
PyroSim uses the equations given in section 4.4.2 of the users guide for version 4 of FDS. The
result is then checked to ensure that the total molecular weight is the same as the specified molec-
ular weight. If this check succeeds, no warning will be issued. If the test fails, PyroSim will is-
sue a "Converted stoichiometry" warning and you must manually update reaction data to ensure
accurate simulation results.

Surfaces

Some surface properties are converted with no additional input or warnings, including surface
names, colors, and textures. The different surface types, however, undergo more complicated
conversions. The following describes how PyroSim 2006 surface types are converted to Surfaces
and Materials in PyroSim 2007:

• Inert and Adiabatic - converted directly.

• Burner Fire - converted to a Burner Surface.

• Fan/Wind - converted to a Supply surface if the air flow is negative, an Exhaust surface, oth-
erwise.

• Flammable Solid of Fixed Temperature or Heat Flux - converted to a Heater/Cooler surface.

• Thermally Thick/Thin Flammable Solid - converted to a Layered Surface with one single-step
reacting Material.

• Flammable Solid (Constant HRR) of Fixed Temperature or Heat Flux - converted to a burner.

• Thermally Thick/Thin Flammable Solid (Constant HRR) - converted to a Layered Surface
with one non-reacting Material. The reaction is controlled at the surface.

• Non-Flammable Solid of Fixed Temperature or Heat Flux - converted to a Heater/Cooler.

• Thermally Thick/Thin Non-Flammable Solid - converted to a Layered Surface with one non-
reacting Material.

• Liquid Fuel - converted to a Layered Surface with one Liquid Fuel Material.
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• Charring Fuel - converted to a Layered Surface with one layer. The layer is composed of
a water and a virgin material. The virgin material undergoes one reaction where half of it
is converted to fuel and the other half is converted to the charring material specified in the
original surface. This ratio may need to be adjusted after conversion.

• Liquid Thermoplastic - converted to a Layered Surface with one Liquid Fuel Material.

• Charring Thermoplastic - converted to a Layered Surface with one single-step reacting Ma-
terial.

Thermally Thin Surfaces

Unlike PyroSim 2006, PyroSim 2007 requires that every layered surface specify a thick-
ness (Delta) for each layer and that materials specify density (Rho), specific heat, and
conductivity (C). In PyroSim 2006, there were a number of ways for thermally thin sur-
faces to either specify or omit these parameters. These surfaces allowed any one or more
of C, Delta, and Rho to be specified in addition to C*Delta*Rho. PyroSim 2007 will
make a best-effort calculation of missing parameters. For instance, if C*Delta*Rho is
specified along with two of the parameters, the third will be calculated; however, if more
than one parameter is missing, PyroSim will use defaults for up to two of the parameters
and calculate the third missing one. The default thickness for thermally thin surfaces
is set to 1mm. In all cases where a default number has been assumed due to a missing
parameter, a warning will be shown for the parameter.

Where is the Surface Database?

PyroSim 2007 does not currently ship with a surface database, but users can still make
their own. In fact, many different objects can now be put into a database including ma-
terials and surfaces, extra species, reactions, particles, and several more. As common
surface descriptions and other of these object properties become available from reliable
sources in a format supported by version 5 of FDS, PyroSim will again ship with a pre-
filled database.
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